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1 ESCALATORdesigner Quicktour  

This ESCALATORdesigner  Quicktour provides an introduction to the program, 
walking you through the creation of an escalator design project using the DigiPara 
ESCALATORdesigner.  

 

 This symbol identifies paragraphs with instructions for operations or for data 
that you need to enter.  

 This symbol identifies paragraphs containing important information and 
warnings. 
 

We hope that you will enjoy working with the new, powerful ESCALATORdesigner. 

 

2 ESCALATORdesigner Basis Information 

2.1 The Basic Structure of the Program 

ESCALATORdesigner  has two main components: 

 

Designer: This is the main part of the program. It includes the user interface that 
enables you to edit the properties of your escalator. To change dimension values, 
just edit the corresponding property in the Properties docking window. 

All changes are automatically implemented throughout the entire data model.  

 In the Stand-alone version of ESCALATORdesigner, direct editing of 
components / dimensions in the drawing and editing of the pre-defined sheets 
are not available. All modifications can be made via the ESCALATOR 
Components / Properties docking windows. This makes the project 
development more efficient and prevents the user from making mistakes.  

 

Database: The specifications and geometrical data of escalator design 
components are stored in the ESCALATORdesigner database. DigiPara 
continually updates this database with the latest components and data.  

2.2 User Interface Configuration 

After the program has been started for the first time, you will see that the toolbars 
are displayed on top of the main program window.  
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 To display or hide the toolbars, click on the right mouse button in the toolbar 
area and click on “Customize” in the appearing context menu. 
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2.3 ESCALATORdesigner Toolbars 

The following toolbars are available in ESCALATORdesigner 

 

 

 

1. File and docking Window operations 

2. Project settings like sheet selection, Color and line weight settings 

3. Drawing languages (to be configured first). 

4. View commands and object select operations. 

 

You can move the toolbars to any position on the screen (left mouse-click on a 
toolbar and drag it).  

 

 

 

Whenever you create or open a project file (*.LD3), a new ESCALATORdesigner 
document window is opened automatically. ESCALATORdesigner  will look 
something similar to the example shown above. 
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2.3.1 Edit Toolbar 

 
 

From left to right: 

 

1. Zoom All: Adjust the zoom scale to show all the views available in the 
current drawing. New: Use the mouse scroll wheel, see picture 7 in chapter 
4.1.2. 

2. Zoom Previous: Restores the last drawing zoom scale. 

3. Move: Enables you to move the drawing within the current window by 
clicking on two points to define the move (the distance and direction 
between points 1 and 2 & specify the move). Alternatively, you can also 
move the drawing with the cursor keys. New: Use the right mouse button, 
see picture 4 in chapter 4.1.2. 

4. Zoom In: Enlarges the current zoom view or press the “+” key, or use both 
mouse buttons and move the mouse. New: Use both mouse buttons or the 
mouse scroll wheel, see pictures 5/6 in chapter 4.1.2 .  

5. Zoom Out: Opposite of Zoom In (or press the “-” key). See picture 5/6. 

6. Zoom Window: Clicking on the two diagonally opposite corners points of an 
imaginary rectangle & it zooms the selected rectangle to fill the window.  

7. Measure: Click on the left mouse button to specify the start point, move the 
mouse and click on the left mouse button again to specify the end point. 
You can also press the spacebar to define the start point, then move the 
mouse cursor and press the spacebar a second time. 

 

2.3.2 How to use the Mouse 

4. 5. 6. 7. 

 

 

 

 

 



6 ESCALATORdesigner Basis Information   _ 
 

__________________________________________________________________ 

© DigiPara GmbH  ESCALATORdesigner Quicktour 

 
 
 

2.3.3 Project Toolbar: 

 
 

From left to right: 

 

1. Select Sheet: Provides the opportunity to switch between the loaded sheets.  

2. Background color: Switch between black and white background colors. 

3. Linestyle: Toggle line thickness on/off. Important for direct printouts. 

4. Foreground color: Switch between colored and monochrome foreground 
color. Important for direct printouts.  

5. Plotstyle: Switch between different plot styles for the selected BG / FG color 
and line style configuration. 

2.4 ESCALATORdesigner Components and Properties 

If you don’t see the ESCALATORdesigner Properties, ESCALATOR Components 
or 3D View docking windows in the main window, you need to activate them via the 
“Window” menu: 

 

 
 

2.4.1 ESCALATOR Components Docking Window 

The ESCALATOR components docking window is being used to administer the 
escalator design components. It displays the escalator components in hierarchical 
order.  



     ESCALATORdesigner Basis Information   7 

 

__________________________________________________________________ 

ESCALATORdesigner Quicktour  © DigiPara GmbH 

If one of the escalator components is selected via the ESCALATOR Components 
docking window, the corresponding properties will automatically be displayed in 
the Properties docking window. 

In the following example, the Escalator A properties will be explained. 

(It may be helpful to first learn about creating a new ESCLATOR to do the example 
below, if so, please refer to chapter 4 ESCLATORdesigner Wizard.) 

 

 Click on the Escalator A item in the Escalator Components docking window.  

 

 

 

  Now switch to the Properties docking window. The properties for the selected 
Escalator A item are displayed. 
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2.4.2 Properties Docking Window 

In the Properties docking window, the properties of the currently selected escalator 
component are displayed. In the following example, the Escalator A properties will 
be explained. 

 

1. The Tools section contains the option to activate or deactivate the selected 
escalator component. 

 

 

2. The General section contains component specific information. 

Description: Displays the component description.  

Sub Description: Displays the sub-description (if available) of the selected 
component. 

 

3. The Truss Dimensions section contains truss specific information. 

Upper Truss 
Length: 

Provides the opportunity to change the length of the upper 
truss. 

Lower Truss 
Length: 

Provides the opportunity to change the length of the lower 
truss.  

Lower Truss 
Height: 

Provides the opportunity to change the height of the 
horizontal truss part at the lower floor 

Upper Truss 
Height: 

Provides the opportunity to change the height of the 
horizontal truss part at the upper floor. 

Truss Height: Provides the opportunity to change the height of the 
inclined, intermediate truss part. 

 

The property in the Truss settings section provides the opportunity to change the 
inclination of the selected escalator (only values between 20° and 35° degrees are 
allowed).  

 

4. The Pit Dimensions section provides pit specific options. 

Pit Length: Provides the opportunity to select a component surface / color 
from a list of available surfaces. 

Pit Height: Provides the opportunity to change the angle of the selected 
component texture. 
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3 ESCALATOR Wizard 

The Escalator Wizard helps you select a standard escalator design configuration 
and to define the basic parameters of the new escalator project. Start a new 
project by clicking on File and selecting New Escalator from the menu. This opens 
the ESCALATOR Wizard, which provides a standard set of escalator design 
configurations.  

 

 The main purpose of the Escalator Wizard is to select a standard escalator 
configuration as a basis for your project. When you are starting a project with a 
new escalator configuration that you have never used before, use the Escalator 
Wizard to define the escalator type and other basic parameters. (The standard 
version of ESCALATORdesigner does not include standard specifications for 
the products of specific companies.) 

 The escalator components included in the project when the Escalator Wizard 
closes, are automatically read from the “duty tables”. This is where the product 
data for the specific escalator types are stored. 

3.1 Escalator Wizard Dialog  

 

 

 

1. Contains the controls for the selection of the escalator count and the 
escalator arrangement.   
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2. The tree view control provides the opportunity to switch between the 
properties of the main escalator components which are shown in the 
properties grid on the right side of the dialog. 

1. The properties grid provides the opportunity to modify / edit the major 
properties for the main escalator components selected via the tree view 
control.  

2. This arrangement control provides the opportunity to change the 
arrangement for the selected number of escalators by clicking with the 
left mouse button.  

3. Contains the controls for the selection of the drawing language as well 
as the control for the selection of the sheet to be loaded. 

 

3.2 Creating a new Project 

 In the Escalator Wizard, select e.g. the following: 2 Escalator Units and a 
scissor arrangement 

 You can change the arrangement either by clicking on the arrangement image 
in the wizard dialog or by selecting the appropriate arrangement via the 
corresponding combo-box in the top section of the dialog. 

 

 

 

 A maximum number of 4 escalator units per project are supported. 
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 You can change e.g. the floor height  by clicking on the Floor1 item in the tree 
view and change the corresponding Floor Height property to any value e.g. 
5500 mm. This can also be done for the second floor when selecting the Floor2 
item. 

 

 

 

 To add intermediate supports, click on the appropriate escalator item in the tree 
view (item A for Escalator A, etc.) and select the number of supports as well as 
the position in x direction via the properties in category 06.  
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 To crate the new project click on the GO! button finally. The project is created 
immediately. 

3.3 Changing Escalator properties 

The Escalator properties / dimensions can be changed via the Escalator 
Components and the Properties docking window. These docking windows can be 
enabled via the Window menu, by clicking on the appropriate item.   
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3.4 Changing the Truss 

Each single escalator truss can be changed by clicking on one of the Escalator x 
item in the Escalator Components docking window. The corresponding escalator 
properties can then be changed in the Properties docking window. 

 

 

 

3.5 Changing the Balustrade 

The balustrade extension on the lower and upper floor can be changed by clicking 
on the appropriate Balustrade item in the Escalator Components dialog and 
changing the corresponding values via the Properties docking window. 
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3.6 Changing the Intermediate Supports 

The position of the intermediate support in x-position can be changed via the 
corresponding properties. To change the position of the intermediate supports, 
click on one of the Intermediate support items in the Escalator components 
docking window and change the corresponding X-Position value. 
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3.7 Changing the Floor properties 

Changing the properties of the floor items is similar to changing the properties of 
the escalator components. Just select the floor component item in the Escalator 
Components docking window and change the appropriate property via the 
Properties docking window afterwards. 

4 Escalator Sheets 

As mentioned in the introduction, the escalator sheets can not be modified in the 
standalone version of ESCALATORdesigner. By default, two different sheets get 
loaded when creating a new project. You can switch between these two sheets via 
the sheet selection in the Project toolbar or via the sheets selection in the Sheets 
menu. 

 

 
To modify the predefined sheets, we recommend to export them into AutoCAD via 
the Export Drawing (File -> Export DWG) dialog and to customize the sheet in this 
environment. 
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5 Drawing Translation 

The predefined messages shown in the drawings are translated into two languages 
by default, German and English. If you want to translate these messages into your 
country specific language, you can do this by adding your translation via the 
Translation dialog. Open the translation dialog via the Translation button in the 
Standard toolbar or via the Translation item in the Project menu. 

 

 

 

 In the Translation dialog, you can select your country specific language via the 
Default language for new records combo box. 

 

 
 

 Select the record to be translated and click on the 
L_DrawingLanguageMessageTab button afterwards to add a new translation 
record for the selected message.  
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 Repeat this step for all translated messages. Leave messages which are not 
translated by default, empty. 

 

 Finally after you are finished your translation, you can switch the drawing 
language via the translation toolbar, by just selecting the appropriate language 
item, e.g. Polish. 

 

  

 The translation must only be done once. Afterwards it is available in all new 
projects which are created with ESCALATORdesigner. 

6 3D View  

The 3D View docking window always shows the 3D model of the created escalator 
model. It is updated automatically when the escalator model gets changed via the 
corresponding escalator component properties. 
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The 3D Model can be exported as a full structured DWF file via the save as button 
in the 3D View control.  
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